eAuthentication Frequently Asked Questions
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1.0 Questions relating to Customer Account Creation

1.1 Who can use eAuthentication?
Any public customer who would like to conduct business with the USDA can establish an eAuthentication
account on this website. However, an account with Level 2 access is required to conduct official business
transactions with the USDA via the Internet.

1.2 Do | have to apply for a Level 1 account and then obtain another one for

Level 2 access?
No. You only need a single account to do business with the USDA at any eAuthentication- protected
website. However, an account with Level 2 access is required to conduct official electronic business
transactions with the USDA via the Internet. Once you have a Level 1 account, you can upgrade to Level 2
access by proceeding with our identity-proofing process.

1.3 The Customer Profile won’t accept the User ID | have created. Why? The User ID is
already in use by someone else. Since User IDs are required to be unique, you cannot use the same one.

1.4 Isigned up for an eAuthentication account with Level 1 or 2 access. What

is my next required step?
ALL levels of eAuthentication access require you to follow the directions in the Confirmation email you
received at the email address provided in your profile. Please follow the steps in Section 2.5 of this
document, “l don’t see a confirmation email from the USDA.” If you need additional assistance, click
here for support contact information.

1.5 Idon’t see a confirmation email from the USDA.
It is common that anti-spam software in your email application or at your email servers can interfere
with the USDA's confirmation email message to you.

Please try the following:
a. Checkyour "junk" folder, as some email applications may incorrectly place this email there

b. Lookin folders other than your "Inbox" such as "SPAM," "Bulk," or "Suspected SPAM."
c. Inaddition, some Internet Service Providers include a service that captures suspected SPAM and
maintains these files outside of your individual email account.

If you do not receive the confirmation email after 24 hours:
a. Turn off your email provider's filters.
b. Turn off your personal email filter settings.
c. Please check that you have disabled any forwarding or anti-spam measures.

If it has been more than one day since the account was created, and you have tried all the above
steps, click here for support contact information


https://www.eauth.usda.gov/mainPages/eAuthContactUs.aspx
https://www.eauth.usda.gov/mainPages/eAuthContactUs.aspx

1.6 I never found my confirmation email it’s been a day and still no confirmation

email. What now?
If you need additional assistance, click here for support contact information. Provide your first and last
names and the User ID for the account you created.

1.7 Ican’t get the link in the confirmation email to work. What now?
At the bottom of the confirmation email is a long string of alphabetic and numeric characters. Copy and
paste the entire string of characters into the address window of your browser, and press the Enter key.

Note: If you need additional assistance, click here for support contact information. Please include your
User ID and the date you attempted to confirm your email.

1.8 Isigned up for an account with Level 2 access and confirmed my email address.
What now?

You must visit a local USDA Service Center in person for identity proofing. (Find an LRA) Take your
government-issued photo ID to the nearest USDA Service Center most convenient to you for identity-
proofing.

The government-issued photo IDs that are accepted for eAuthentication Level 2 account activation are:

1.8.1 State- or Province-issued Driver's License or Photo Identification card from the United States
or Canada.

1.8.2 US Military or US Federal Government employment PIV/CAC (Smart) identification card
(DoD, DoS, DHS, etc.).

1.8.3 Valid passport from one of the following countries: Andorra, Australia, Austria, Belgium,
Bermuda, Brunei, Canada, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece,
Guam, Hungary, Iceland, Ireland, Italy, Japan, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta,
Mariana Islands, the Marshall Islands, Mexico, Micronesia, Monaco, the Netherlands, New
Zealand, Norway, Portugal, San Marino, Singapore, Slovak Republic, Slovenia, South Korea
(Republic of Korea), Spain, Sweden, Switzerland, the United Kingdom or the United States of
America.

Note: Your first and last names and date of birth must appear exactly as they appear on your
government-issued photo ID that you present at the Service Center. If they do not match, you will
need to create another account that has matching information and use a different User ID.

1.9 llogged into my Level 2 account and was prompted to answer questions. Why did
this happen?

USDA eAuthentication is trying to make it easier for all customers to retrieve their forgotten password

and increase account security. The security questions and answers are a way to make your information
more personal (memorable) and more difficult to research. You will be asked to answer these questions if
you forget your password in the future.


https://www.eauth.usda.gov/mainPages/eAuthContactUs.aspx
https://www.eauth.usda.gov/mainPages/eAuthContactUs.aspx
http://offices.sc.egov.usda.gov/locator/app?type=lra

1.10 How do | locate my nearest USDA Service Center?
Please browse to find an LRA. This site will help you to identify a USDA Service Center with an LRA, and will
provide you with contact information and map directions to help you find it.

1.11 How do I register for a Customer account?
For step-by-step instructions of the Customer account registration process please review the
Customer Registration Job Guide.

2.0 Questions relating to your password or User ID

2.1 How do | keep my eAuthentication account active?

The eAuthentication system does go through a periodic cleanup of any accounts that have not been
accessed in over 400 days. If you would like to keep your account active, please log into your account at
least once per calendar year.

2.2 Howdo I change my password?

There are two methods to changing your eAuthentication password.

If you are able to log into your eAuthentication account, log into your account first.
2.2.1 Go tothe Home page.
2.2.2 Click on “Update your account” in the Quick Links box.
2.2.3 Login using either your LincPass or your User ID and Password.

1. Ifyou login using your LincPass, select the correct certificate.

2.2.4 Click on “OK.”
2.2.5 Enter your LincPass PIN when prompted.

Once you have logged into your account, you will need to do the following:
2.2.6 Go to the Home tab and select “Change my eAuthentication Password”
2.2.7 Please review Question 2.8 for information about our password guidelines. Once you
have selected a valid password and confirmed it, please click on the "submit" button.


http://offices.sc.egov.usda.gov/locator/app?type=lra
https://www.eauth.usda.gov/
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_Registration_External.pdf

2.3 I've forgotten my password. How do | obtain a password reset? Please
follow the steps below to reset your forgotten password:

Go to the Home page.

Click on “Update your account” in the Quick Links box.

Below the “Password” field, click on the “I Forgot my Password?” link.
Follow the steps to reset your forgotten password.

An email will be sent to your email address on record.

P oo oo

For more information, please review the following guide:

2.3.1 Forgotten Password Training Guide for External Accounts

If you need additional assistance, click here for support contact information. Please include your
User ID, First Name, Last Name and email address.

2.4 | cannot remember my User ID. How may | recover it? Please follow the steps below

to recover your User ID:

Go to the Home page.

Click on “Update your account” in the Quick Links box.

Below the “User ID” field, click on the “I Forgot my User ID?” link.
Follow the steps to reset your forgotten User ID.

An email will be sent to your email address on record.

P oo oo

For more information, please review the Forgotten User ID Customer Training Guide.

If you need additional assistance, click here for support contact information.

2.5 What are the “Reset My Forgotten Password” feature and the “Retrieve
My Forgotten User ID” feature?

Please review the following User Guides for more information on these features:

2.5.1 Forgotten Password Training Guide for External Accounts

2.5.2 Forgotten User ID Customer Training Guide

2.6 Why does the eAuthentication system require such complicated passwords?

eAuthentication protects websites that involve submitting personal and private information, as
well as financial transactions, via the Internet. eAuthentication security standards are
consistent with USDA policies as well as those established by the National Institute of Standards
and Technology (NIST), which determines the security standards for the Federal Government.

2.7 Why is the complexity of my password important to protecting privacy at USDA?

The USDA eAuthentication Service enables USDA customers to confidently share data and conduct
official business transactions with the USDA via the Internet.

To learn more about Protecting Privacy at the USDA, read the Privacy Presentation for End Users.



https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_ForgottenPassword_Customer.pdf
https://www.eauth.usda.gov/mainPages/eAuthContactUs.aspx
https://www.eauth.usda.gov/
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_ForgottenUserID_Customer.pdf
https://www.eauth.usda.gov/mainPages/eAuthContactUs.aspx
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_ForgottenPassword_Customer.pdf
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_ForgottenUserID_Customer.pdf
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_SecurityResponsibilitiesForEndUsers.pdf
https://www.eauth.usda.gov/

2.8 What are the criteria and rules governing passwords within the

eAuthentication system?

Please create a password that you will remember. Your password is case sensitive. Passwords must follow
these guidelines:

A minimum of 12 and a maximum of 24 alphanumeric and special characters including at least one of each of

the following:

e uppercase letter

e Jlowercase letter

e anumber

e one or more of the following special characters | #S5 % =+:;,? ~ * - (spaces are not allowed)
e Dictionary words may not be used in passwords

e The previous 24 passwords may not be re-used

The key to making your eAuthentication account as secure as possible is creating the strongest possible
password while making it easy to remember. The following are guidelines that will help you do this:

Password Tips:

Make your password lengthy. Your password must be a minimum of 12 characters; however the
longer you make the password, the harder it will be for someone to guess. Therefore, try to make
your password up to 24 characters long.

Avoid repeated characters or common character sequences. Do not use more than one or two
letters or numbers together (for example: “11111111” or “aaaaaaa”.) Also avoid common sequences
such as “qwertyuiop” , “123456789”, or “abcdefghij”. These sequences are too easily guessed.

Avoid use of dictionary words of any language. Many hackers use dictionary words of many
mainstream languages, including slang, to guess passwords. If you use these in your password, it
makes it easier to guess by a hacker.

Make your password difficult to guess or research. One technique is to pick a favorite quote, song
lyric, or phrase and use the first character from each word or syllable to build a password.

This will help you select a nonsense word that can’t be compared to any known dictionary word and
should be un-related to any identity details known or researchable about you.

Avoid obvious character substitutions. Replacing the letter “i” with 1 or the letter “o” with 0 does
little to prevent a password guessing attack.

Do not use the same password in all systems. If one of the online systems or computers you use is
compromised, then the attacker could potentially have access to all of your systems. Make sure you
use a distinctly different password for all of your systems.

Note: Your password will expire according to USDA policy. Please review the Tips on Creating a Strong
Password guide to learn more about creating a strong password for your eAuthentication account.



https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_TipsForCreatingAStrongPassword.pdf
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_TipsForCreatingAStrongPassword.pdf

3.0 Questions relating to web browsers and
eAuthentication website security

3.1 What kind of browser do you recommend using?
It is recommended that you use Internet Explorer 8 or higher. Other IE versions and other browsers (e.g.,
FireFox, Chrome) can also be used.

It is recommended that your browser support 128-bit encryption, accepts cookies, and is JavaScript
enabled.

For more information about Internet Explorer, please access Microsoft Internet Explorer support site

3.2 | keep getting re-directed back to the login screen after | click the “Login” button.

Enabling “Compatibility View” in Internet Explorer may resolve this issue. To set Compatibility View in IE:

Note: if Compatibility View Settings is not an available option, you may need to contact your network
administrator for assistance.

a. Press Alt + T to open the Tools menu in IE

b. Look for the “Compatibility View” menu option and click on it

c. This will turn on Compatibility View

Microsoft also provides a tutorial video on Compatibility View usage:

http://windows.microsoft.com/en-US/windows7/How-to-use-Compatibility-View-in- Internet-Explorer-9

If setting Compatibility View does not resolve your issue, click here for support contact information.

3.3 What is the security level of the registration website?
All eAuthentication web pages are encrypted with Secure Socket Layer (SSL) encryption.
The encrypted connection indicates the website is secure and can be verified by seeing the SSL symbol (a

padlock in Internet Explorer) in the browser. A mouse-over on the symbol shows that SSL encryption is
being applied to the connection.


http://windows.microsoft.com/en-us/internet-explorer/use-compatibility-view#ie=ie-11-win-7
https://www.eauth.usda.gov/mainPages/eAuthContactUs.aspx

3.4 Why does the eAuth login page look different on my mobile device?The
eAuthentication login page was updated to automatically detect mobile devices, and will now present a
simple, friendly and appropriately-sized login screen to mobile users.

When you visit an eAuthentication protected application with your mobile device, you will
automatically be routed to the mobile version of the login page. The page will look like this:

If you prefer to use the desktop version of the login page, click “View Desktop Version”
below the LOGIN button.

UsbDA
eAuthentication

If you need to use the self-service links to remember your User ID, reset your forgotten
password, or change your password, click “View Desktop Version” and click the links for
self- service on that page.

Note: Your device’s browser must be configured to accept cookies; refer to your device manual for
instructions.

4.0 Questions relating to My Profile Information

4.1 Why s it important to keep my contact information current?
The business email address and phone in your eAuthentication profile may be used to keep you informed
about important eAuthentication matters related to your account.

4.2 How do | change the answers to my security questions?

Security questions assist in account protection and self-service. If you need to view or change the
answers to your security questions, please follow these steps:

4.2.1 Loginto eAuthentication Identity Manager by going to https://www.eauth.usda.gov and
selecting “Update your account” on the left.

e If you have an Internal USDA eAuthentication account, please use your LincPass
to login.
4.2.2 Click on the “Home” tab and select “Modify My Security Questions.”

4.2.3 Once you have finished modifying or viewing your questions and answers, click the Submit
button in the bottom right corner of the screen.

4.2.4 You can exit Identity Manager by either clicking the “Logout” link at the top or by closing your
web browser.


https://www.eauth.usda.gov
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